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0 Accessibility in Digital Teaching and 

Learning 

It is estimated that one in ten people in Switzerland lives with a disability or 

chronic illness. This also applies to students. 

The University of Basel is committed to the inclusion of students and researchers with 

disabilities or chronic illnesses: they should be able to study and conduct research 

without obstacles. Accordingly, relevant guidelines are set down in several university 

documents. Moreover, accessibility is mandated by law. 

Accessibility means that obstacles for people with disabilities or chronic illnesses are 

removed or compensated for. The University of Basel does this in a variety of ways, 

from wheelchair accessibility to inclusive assessment arrangements during exams. 

This guide will show you the fundamentals of how to use digital teaching methods and 

materials if there are students with disabilities in your group.  

For other questions regarding accessibility, students as well as instructors are invited to 

contact the Students without Barriers (StoB) service point. 

 

Feedback 

Is anything missing? Does your software differ from these guidelines? Please email any 

feedback on this guide to: digital-literacies@unibas.ch. 

 

  

  

https://www.unibas.ch/en/Studies/Advice/Social-Services-Healthcare/Disability---Illness.html
mailto:digital-literacies@unibas.ch
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1 How to proceed 

1.1 Accessibility in my class  

How and when do I find out if my class will include students with disabilities?  

First, and most importantly, there is no standard procedure. Often several people and 

offices are involved, all working to find the best solutions. So keep your eyes open and 

maintain open channels of communication. 

At the beginning of their studies, all new students are informed that they should contact 

the StoB service point if they have special needs related to a disability or health 

condition. Most affected students are able to communicate their needs in this way. They 

are granted accommodations and are well equipped for the remainder of their studies. 

The Offices of the Dean of Studies for the various faculties act in close collaboration with 

StoB and confirm the accommodations. 

For individual courses, the students concerned generally contact faculty members 

directly. Most advanced students are “experienced” enough to recommend the best 

solutions themselves. Faculty members can follow these suggestions as well as the list 

of possible accommodations from StoB. If you need further assistance, the Offices of the 

Dean of Studies and StoB can help, or in certain cases external specialists or 

organisations. 

Some students will first contact the Office of the Dean of Studies or the Student Advice 

Center, who will then get in touch with the relevant faculty member(s) and/or StoB. 

Nonetheless, you should always invite students in need of accommodations to contact 

you before and at the start of every course. 

1.2 Before the course begins  

As a lecturer, you are responsible for making your course as accessible as 

possible. Please consider the following points when planning your course. 
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In your first informational email to students, encourage them to contact you if they have 

any special needs related to a disability or health condition. This will allow you to make 

your course accessible from the start. Sample language for this communication as well 

as information about various disabilities and chronic illnesses is provided in the StoB info 

sheets. 

In the first session of each course, ask again whether anyone in the group has special 

needs, and ask them to get in touch with you to discuss it. 

If you are unsure what words to use when speaking or writing about disabilities to avoid 

offense or hurt feelings, please consult these guidelines from the University of Basel’s 

Diversity Office. 

The StoB service point is also open to you as a lecturer. Cooperation between all 

relevant offices and individuals is critical and will provide the best solutions for the 

affected students. 

After you have clarified your students’ needs, you can plan the tools and media for your 

course. Accessibility requirements are highly varied, but they can be divided into the 

following broad categories: 

• For students with visual impairments and some motor impairments, text 

documents must be formatted appropriately and videos must include transcripts.  

• For students with hearing impairments, audio and video content must be specially 

formatted/edited.  

• Particular attention must be paid to video conferences and online lectures and 

seminars.  

 

https://www.unibas.ch/en/Studies/Advice/Social-Services-Healthcare/Disability---Illness.html
https://www.unibas.ch/en/Studies/Advice/Social-Services-Healthcare/Disability---Illness.html
https://www.unibas.ch/en/University/Administration-Services/Vice-President-s-Office-for-People-and-Culture/Culture-Diversity-and-Leadership-Development/Diversity-and-Inclusion/Diversity-Management/Gender-Sensitive-Language.html
https://www.unibas.ch/en/University/Administration-Services/Vice-President-s-Office-for-People-and-Culture/Culture-Diversity-and-Leadership-Development/Diversity-and-Inclusion/Diversity-Management/Gender-Sensitive-Language.html
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2 Text and Visual Elements 

2.1 Reading with a visual impairment  

For students who are blind or visually impaired, text poses a particular challenge. 

However, there are digital solutions and some simple steps that make text 

accessible. 

Blind and visually impaired students can use screen reader software to read digital text 

aloud or translate it into braille. Instead of navigating with a mouse, they use keyboard 

shortcuts, similar to people with motor disabilities.  

Some people with residual vision may also read on screens with very large text or with a 

magnification tool; people with tunnel vision may use very small text. Some will use 

colour inversion to adapt a document to their needs. In some cases, blind and visually 

impaired students may also rely on the services of an assistant. 

Your text must therefore fulfil two requirements – regardless of whether students receive 

it as a document, website or email: 

• Your text’s structure and content must be understandable for screen readers and 

other computer programs.  

• The text must be visually organised in a way that is readable for people with 

visual impairments.  

A layout that is well-structured and as simple as possible will fulfil both requirements – 

and is also advantageous for students without a disability, as it makes your text easier to 

read. 

In general, editable document formats such as MS Word are easier for people with 

disabilities, as they can adapt them to their needs themselves. Please consider carefully 

whether it is really necessary to provide all files in PDF format. If it is a matter of 

copyright, students can sign a declaration that they will not share the content with 

others. 
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Accessibility rules apply equally to all text, regardless of the format in which it is 

published (text document, slide, website or email).  

This chapter provides the basic guidelines. Step-by-step instructions for various software 

programs can be found in Chapters 4 to 7 of this guide. 

2.2 Accessible text layout  

In principle, it is not difficult to design a text document for people with visual 

impairments; however, a number of details must be kept in mind. These details 

and the relevant technical instructions are listed in Chapter 4. In this chapter, we 

provide the basic guidelines. 

Using styles 

Styles are the most important tool to make your text accessible in terms of structure and 

appearance. The use of Styles to organise text is a widespread software principle. For 

this reason, you will find that many computer programs use styles. 

• Styles structure a document so that a screen reader can accurately recognise 

and reproduce various elements, such as headings, running text or image 

captions.  

• Styles allow the various elements to be formatted and organised as groups.  

• In this way, they facilitate a consistent visual layout in accordance with the 

principles of accessibility.  

• Styles make it much easier to change the layout: instead of making layout 

changes in each individual location, you can just change the style format.  

The following aspects of text accessibility can all be set using styles. 

Font 

• Sans serif fonts, such as Arial, Calibri and Tahoma, are easier to read for people 

with visual impairments than serif fonts, such as Times New Roman or 

Garamond.  
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• It is best to use a black font on a white background. This provides the best 

contrast. Combinations of red and green or blue and green should be avoided.  

• Your font size should be at least 12 pt. Headings may be larger. Use black on 

white because people with visual impairments require plenty of visual contrast, 

and colour inversion also works best with black-and-white text.  

• Screen readers often do not recognise special characters such as à or >. Please 

avoid them if possible. The same applies to abbreviations and Roman numerals. 

Please avoid them whenever possible.  

• If you write in German and need to gender nouns, use the colon: Dozent:innen 

and Student:innen. The screenreader will read this correctly as a brief pause. 

Underline (Dozent_innen) or the Asterisk (Student*innen) would be read as 

“underline” or “asterisk”. 

Paragraph formatting 

• In the body of the text, use 1.5 line spacing. Use even greater spacing before and 

after headings.  

• Vertical spacing – for example, before headings or between paragraphs – can be 

set up in Styles. Avoid accumulations of carriage returns. Spacing after a 

paragraph makes it easier to read magnified text.  

• Horizontal spacing should be avoided whenever possible, as it is difficult to 

navigate for people reading magnified text. (More about this in Chapter 5: Visual 

Elements.) However, if a horizontal space in a line is necessary for some reason, 

create it with the tab key. Avoid long rows of spaces.  

Headings 

In order for the screen reader to accurately recognise the structure of a text, you must 

use hierarchical headings. Use the preset headings in MS Word; they are easiest for the 

screen reader to understand. (The appearance of headings may have to be adjusted, 

however; see Chapter 4.2) 
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Page formatting 

Do not make left and right margins too narrow (i. e. do not make lines too long). This 

way, people reading highly magnified text can move smoothly from one line to the next. 

Lines of approximately the same length will also make navigating the text easier. 

Additionally: 

• Turn off automatic hyphenation  

• Insert page numbers  

• Insert page breaks  

• Use a single-column layout  

• Do not use text boxes   

Dark Mode 

Students with migraines, cluster headache or other neurological conditions may have 

difficulty reading on a glaring white background, as this might provoke an attack. In such 

cases and if possible in the software you’re working with, you should adapt the 

background and font colour (e. g. in slides) or provide a “dark mode” layout for your 

website. A dark grey background with an off-white font is best. 

2.3 Visual elements  

Visual elements, such as images, diagrams, tables and lists, present some 

challenges for screen readers and for people who read with magnification. Here, 

we will show you how to make these elements accessible. 

For structuring your text, do not use the tab key, but use table, list and/or paragraph 

formatting instead. Paragraph formatting also allows you to set an indentation for an 

entire paragraph. You will find detailes instructions in Chapter 5 of this handbook. 

Lists 

For creating lists, use the preformatted list styles. 
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Tables 

Tables are difficult to understand for people using screen readers. Screen readers read 

tables line by line; as a result, the connections between the rows and columns are lost. 

This makes it hard for people who are dependent on screen readers to understand 

complex tables. You may either replace the tables with lists or else make them 

understandable for the screen reader with bookmarks. 

Images and diagrams 

All images and diagrams in your texts, emails or websites must be accompanied by 

alternative text, which the screen reader will read out. Images that are purely decorative 

must be labeled as a decorative elements. 

It is also important to ensure adequate contrast in graphics and diagrams. 

Provide a caption for all images and diagrams and number them. If the connection 

between images and text is not obvious, assign an anchor tag to the image. 

Avoid watermarks – they are visually confusing. 

More detailed information can be found in Chapters 2.4 and 5.2 of the handbook. 

2.4 References, language and metadata  

Well-organised references are important in order for blind and visually impaired 

students to be able to navigate your document. Metadata help them to store the 

document in a logical place and find it again.  

Table of contents 

The scroll function is useless for the blind, and people with motor disabilities may find 

scrolling difficult or impossible. A linked table of contents at the beginning of each 

document is therefore indispensable. 

All other references should also be formatted as clickable hyperlinks: 

• Within a document (for example, “see Chapter 2”)  

• From a document to a website  
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• Within a website  

• From a website to a file: If you link to a downloadable file (e.g. a PDF or an audio 

file) from your website, indicate the file type and size: “Read this text as an article 

(PDF, 4 MB)”  

All links must always be marked with a descriptive link title. If the title is missing, screen 

readers will only read “link” without naming the destination. More details on creating links 

and references can be found in Chapter 7. 

Bibliographic data/footnotes 

Bibliographic data are also references. Whenever possible, put these in footnotes. Inline 

citations break up the screen reader’s reading flow, making comprehension more difficult 

for blind readers and for visually impaired readers who use large magnification. 

Endnotes are also an obstacle for these readers, as well as for individuals with motor 

disabilities. 

If a document contains footnotes, you should provide it to your students in MS Word 

format. PDFs lose the structural connection between the footnote symbol and footnote 

text, so that the screen reader will simply read all the footnotes at the end of the page. 

Languages 

The languages in a document or website must be marked correctly for a screen reader 

to be able to read the text. A document’s main language can be indicated in the 

metadata, and other languages contained in the text should be marked in the individual 

sections of the document itself. Further details on this can be found in Chapter 7. 

Screen readers usually mispronounce individual foreign words in a text. However, in a 

university context they are often unavoidable. You can assume that your blind students 

will generally be able to understand such terms.  
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Titles and metadata 

Files and websites not only have a file name, they may also be described by various 

metadata. These metadata can be read by screen readers and help your students to 

find/identify the file. 

Watermarks 

Avoid using watermarks. They make the document difficult to read for people with visual 

impairments. 

2.5 Comments and corrections  

Most word processing programs offer comment and track-changes functions. 

However, these are difficult to use for blind and visually impaired people. Here are 

some alternatives. 

If you are adding corrections or comments to a text document for a blind or visually 

impaired student, please note the following. 

• Screen reader programs often struggle with the MS Word comment function – 

they ignore comments in the margins.  

• Screen reader programs cannot reproduce corrections made in track-changes 

mode correctly (or at all).  

It is thus best to write your corrections and comments directly in the body of the text. 

You can mark them as @correction or @[student name], so that the student can identify 

your additions. 

2.6 Slide-based documents  

Presentations with slides present particular challenges for students with 

disabilities. Slides contain many images, diagrams and tables, and the screen 

reader may read the various elements on the slide in the wrong order. 
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It is therefore very important that your students with disabilities receive the slides as a 

document before the presentation. This will allow them to carefully work through any 

content that is missed during the presentation beforehand or afterwards. 

Accordingly, creating accessible slides presents two challenges: 

• First, all visual elements on all slides must be marked with alternative text. This 

can be a particular challenge with charts and diagrams. 

• Second, the elements on the slides (text fields, arrows, diagrams, images) must 

be put in the right order, so that the screen reader reads them correctly. A step-

by-step instruction is provided in Chapter 5.5. 

Both of these steps can be very time-consuming. For this reason, we recommend 

considering whether you can provide the content to your students as a text document. 

This will probably save you time and will be easier for students to understand. 

In Chapter 3.3, you will find guidelines on how to present your slides in an accessible 

manner during video conferences. 

2.7 PDF  

PDFs are practical, but they also pose significant accessibility challenges for 

blind and visually impaired students. Here we will show you how to make your 

PDFs more accessible. 

There are different kinds of PDFs, and they present different accessibility challenges: 

• Text or image PDF  

• Created yourself based on a text document  

• Created yourself based on a scan  

• Downloaded from the internet  

• Created with various programs or versions of programs  

• Different standards  
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PDF metadata 

PDFs save and show metadata. Metadata are particularly important if you are planning 

to make a document available online. The file name will appear in the browser tab and 

the author's name is visible to anyone who downloads the PDF. Therefore, you should 

always check the metadata in your PDFs, regardless of their source. 

Creating a PDF from your own text document 

The simplest way to ensure an accessible PDF file is to create it yourself from a text 

document. If you have followed the directions under “Accessible text layout” when 

creating your source documents, your PDF will also be accessible. 

However, for your students with visual impairments, even a relatively accessible PDF is 

still harder to read than a document in an editable format (MS Word, for example). We 

recommend that you make the document available in the editable format as well – 

ideally, as an MS Word document. If you have concerns about copyright or 

confidentiality, ask your students to sign a declaration that they will not share the 

document with others. 

Making an existing text PDF accessible 

Existing PDFs can be checked for accessibility and modified as necessary. For example, 

it is possible to format text and add alternative text. Instructions can be found in Chapter 

4.10. 

PDF from a scanned text 

Scanning text from a book or journal creates an image PDF. For a screen reader to be 

able to read the text, it must be converted into a text PDF or MS Word document using 

optical character recognition (OCR). The OCR output must be checked and edited as 

needed. This is particularly important with regard to headings, footnotes and alternative 

text for images. 

Further instructions are available in Chapter 4.10. 
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2.8 Checking accessibility  

Before making an accessible document available to your students, it’s a good 

idea to run an accessibility check. 

Using Software to check accessibility 

Various programs allow you to check a document for accessibility, for example regarding 

contrast, proper embedding of images and diagrams, or missing style sheets. 

• MS Word: Review > Check Accessibility.  

• Adobe Acrobat: Most versions of Adobe Acrobat have options for checking 

accessibility; they are however located in very different places depending on the 

version.  

We recommend that you identify the version you are working with and search for 

instructions online. 

There are also some independent programs for checking PDFs for accessibility, for 

example PAC, which is offered by the Access for All Foundation. 

You can also use Adobe Acrobat to check PDFs from other sources for accessibility and 

to make improvements if needed (see Chapter 2.8). 

Checking by read-aloud function 

Ideally, you might consider listening to your documents read aloud by a screen reader. 

However, the programs used by your students (NVDA, JAWS, or VoiceOver) require a 

certain amount of specialist knowledge on the part of the user.  

The read-aloud functions of Windows, Word and Adobe Acrobat are a poor replacement, 

as they don’t work like professional screen readers.  

The best experts are the visually impaired students themselves. Why not employ one of 

them to run your checks for you? 

  

https://www.access-for-all.ch/en/
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3 Audio and Video 

3.1 Audio and video for hearing-impaired individuals  

For students with disabilities, audio and video files pose particular challenges. If 

you plan to use such files in your classes, here are some things to pay attention 

to. 

Transcript 

Audio files or the audio track of a video must be transcribed for people with hearing 

impairments. This can be done manually or with software. Using automatic transcription 

software typically saves about 20 % of time compared to manual transcription. However, 

in specific case – for example, if the speaker has a strong accent or uses a lot of 

subject-specific language – manual transcription may be a better choice. 

Subtitles 

The best way to make a video accessible is subtitling. However, subtitling – in particular 

dealing with the precise time markings – can be very time-consuming for a long video. 

Check whether you can convert the entire video into a text document with images, 

especially if a video mostly contains static images. Transcribing the audio track as a text 

is much less work than subtitling. The transcription could also serve as the basis for a 

text document for visually impaired students. 

You can find instructions for subtitling videos for people with impaired hearing in Chapter 

8.1. 

3.2 Video for visually impaired individuals  

Videos are based on visual information, which makes it difficult for blind and 

visually impaired people to access their contents. However, there are some ways 

to help your visually impaired students benefit from your videos. 
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Transcript 

If you only plan to show your video once, in a class session, a transcript is the easiest 

solution. Describe the contents and also transcribe the audio track, so students can 

navigate the descriptions as they listen to the video. You can find technical guidance for 

transcription in Chapter 8.1.  

Personal assistant 

If your visually impaired students work with a personal assistant, the assistant can 

describe the visual contents of a video. 

Additional audio track 

Videos that you use frequently or want to make available permanently and to a wider 

audience can be equipped with an additional audio track describing what is happening in 

the video. However, creating of such an additional audio track is extremely time-

consuming and is not possible in all video editing programs. For this reason, we do not 

provide technical instructions for this process. 

3.3 Video conferences and online seminars  

Lectures, seminar courses and conferences via Zoom etc. offer students with 

disabilities many advantages, but also some new challenges. Here are some tips 

for making them successful. 

For blind/visually impaired students 

Presentation 

• In your computer settings, select a large and high-contrast cursor symbol.  

• Do not move the cursor too quickly.  

• Announce any slide changes or moves within a slide to a different diagram or 

image.  
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• Explain each image in detail – even if your students received the slides in 

advance. Your students cannot listen to you and to the screen reader’s 

explanations of the slides at the same time.  

Discussion 

• Moderate the discussion carefully.  

• Call on individual students by name.  

• Deactivate the chat or read any relevant chat contributions aloud.  

Chat 

Avoid parallel use of chat and spoken conversation whenever possible. If important 

content was shared in the chat, download the chat at the end of the video conference 

and send the file to your visually impaired students. 

Recording 

Record your presentation and the discussion and make the recording available to 

students to listen to later. 

For hearing-impaired students 

A wide spectrum of hearing impairments exist. Consult your students to learn what 

resources and methods are most helpful to them. Here are some options: 

Live sign-language interpretation 

Deaf and some hearing-impaired individuals prefer to use sign language. A sign-

language interpreter may also be helpful during video conferences. For students with 

Swiss federal disability insurance (DI) support, the DI will typically pay for sign language 

interpretation. 

Live closed captioning 

Closed captioning is also very popular. A closed-captioner transcribes everything that is 

said and the transcription appears in real time on the screen of the hearing-impaired 

person. For students with Swiss federal disability insurance (DI) support, the DI will 

typically pay for closed captioning. 
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Automatic subtitling 

Providers such as Zoom offer automatic subtitling. If your software/license offers this 

option, test its quality before using it during class. Some students with hearing 

impairments have the subtitling app “AVA” installed on their devices and are able to 

follow conversations with its help. 

Hearing aids, software 

If your students use a hearing aid or a subtitling app such as AVA: 

• Use an external microphone  

• Eliminate any background noise  

• Moderate carefully  

Lip reading 

Many hearing-impaired individuals use lip reading in addition to other communication 

strategies and aids. To support lip reading, it is important that you (and all participants): 

• Ensure good lighting (no backlighting)  

• Are sitting close enough to the camera  

• Speak slowly and clearly  

• Moderate carefully: only one person speaks at a time  
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4 Details: Text 

4.1 MS Word: Styles  

MS Word has preset style formatting that will work well for you – with some 

limitations. The style settings can be found in the “Start” menu and can be 

enabled or edited there. 

MS Word’s preset styles are not fully accessible: the standard character size and 

spacing are too small, and the font color for headings is too faint. You will have to 

change these. 

For documents used at the University of Basel, we recommend the university’s “Report” 

template (available on ADAM). It is pre-formatted to be largely accessible. (The “Letter” 

template, on the other hand, is not recommended for digital use, since it is partly 

formatted as a table. This prevents the screen reader from reading it correctly. However, 

it is suitable for a printed letter.) 

If you want to create a document together with other people, we recommend using a 

collaborative online editor such as Google Docs or OnlyOffice on SWITCHdrive. If an 

MS Word document is sent back and forth between multiple computers, the formatting 

tends to become confused, which can make the document unreadable for a screen 

reader. 

Assigning styles 

Every element in your text must be assigned to a style. The quickest way to do this is by 

using predefined styles. 

• Highlight the desired element (e.g. a heading).  

• Click Start > Styles  

• Click the desired style  

Creating a new style 

There are various ways to create a new style. Here is the simplest way: 
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• Design the desired text element manually (with the buttons under “Start”).  

• Highlight the text element.  

• Right click > Styles > Create a style > Name the style  

Modifying a style 

• Right-click the Style > Modify.  

• The first section shows only the style’s general settings. Details can be set in the 

various sub-items, which can be accessed by clicking “Format” at the bottom left.  
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4.2 MS Word: Font and paragraph  

For your document’s main text, you must use the “Normal” style. This is defined 

in MS Word as Calibri 11pt with 1.08 line spacing and 8pt spacing after 

paragraphs. These preset settings do not meet accessibility requirements and 

must therefore be modified. 

To make the “Normal” style accessible for your main text, proceed as follows: 

• Right-click on the “Normal” style and click “Modify”.  

• In the window that appears, change the font size from 11 to 12.  

• You can also change the font, e.g. to Tahoma or Arial.  

• Click the “Format” button at the bottom left.  

• Click “Paragraph” in the list.  

• Change the line spacing from “multiple” to “1.5 lines”.  

It is best to keep to black text on a white background. If you wish to use colour, ensure 

plenty of contrast. Combinations of red and green or of blue and green should be 

avoided. 

4.3 MS Word: Headings  

Correctly formatted headings are absolutely crucial for visually impaired people to 

navigate a document and for a screen reader to recognise a document’s structure. 

The preset headings in MS Word are formatted in Calibri Light in a light blue colour. 

They are too light and faint for many people with residual vision and must be modified: 

Choose a normal sans serif font (i.e. not “light”) and black font color. This can be done 

following the procedure for modifying the normal font style outlined in Chapter 4.2. 

MS Word’s preset heading formats are not numbered. It will help readers navigate their 

way around the document if you use hierarchical numbering.  

To make this change: 

• Write your first heading.  
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• Click in the heading or highlight it.  

• In the “Paragraph” menu, select the drop-down list “Multilevel list” and check the 

box with the hierarchically numbered headings.  

 

MS Word will automatically number all the headings hierarchically.  

 

4.4 MS Word: pages  

A correct basic page layout is important both for people who work with screen 

readers and for those who read with strong magnification on their screens. For 

both groups, it is important use a single-column layout without added text fields. 
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Margins/text width 

It is best to use Word’s preset margins of 2.54 cm.  

If you wish to change the margins, do this in the menu, not on the ruler. (Changes made 

on the ruler always apply only to the selected section of the text, not the entire 

document.) 

• Layout > Margins  

Deactivate hyphenation 

• Layout > Hyphenation  

• Deactivate hyphenation  

Insert page numbers 

Page numbers make it easier for everyone to navigate the document. 

• Insert > Header & Footer > Page Number  

• Add the page number at the desired position  

Page breaks 

Page breaks can be created in two ways: 

• Insert > Page Break  

• or Layout > Breaks > Page Breaks> Page  

4.5 LaTeX: Styles  

LaTeX documents typically heavily rely on styles, which is a good basis for 

accessibility. However, LaTeX’s default layout does not fulfil all accessibility 

requirements, e. g. with regard to font type and size. You should therefore make 

some modifications. 
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Assigning styles 

When working with the word processing program LaTeX, it is almost impossible to avoid 

styles.  

• Main headings and subheadings are marked with \chapter{}, \section{} or 

\subsection{};  

• quotations with \begin{quote}...\end{quote}, etc.  

Proper hierarchical structuring of the elements and consistency in the layout are virtually 

guaranteed with this program. Just make sure to save the document as a PDF and not a 

DVI. 

Modifying a Style 

Modify the layout settings for the whole document in the preamble. 

4.6 LaTeX: Font and paragraph  

Accessible documents must be written with sans-serif fonts. Besides Modern 

Sans, most TeX distributions offer additional high-quality alternatives, including 

Fira Sans and Droid Sans. 

To change the font, add one of these two commands to your preamble: 

• \usepackage[default]{FiraSans}  

• \usepackage[default]{droidsans}  

If you use fontspec, you can easily change the main font, for example: 

• \usepackage{fontspec}  

• \setmainfont{Fira Sans}  

The easiest way to change the font size is in the class options, for example: 

• \documentclass[12pt]{article}  

You can adjust the line spacing with this command: 

• \renewcommand{\baselinestretch}{1.5}  
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By default, LaTeX uses Modern, a serif font. Instead of this, use the sans-serif variant. 

To make this change, add this command to the preamble:  

• \renewcommand{\familydefault}{\sfdefault}  

4.7 LaTeX: pages  

A correct basic page layout is important both for people who work with screen 

readers and for those who read with strong magnification on their screens. For 

both groups, it is important to use a single-column layout without added text 

fields. 

Margins/text width 

The predefined page margins in default LaTeX documents are wide enough. 

Deactivate hyphenation 

The following command disables full justification and deactivates hyphenation for the 

entire document: 

• \raggedright immediately after 

• \begin{document} 

In this case, the spacing between paragraphs should be increased, for example:  

• \setlength{\parskip}{12pt}  

This makes it easier for people who read with magnification to recognise the paragraph 

structure. If you wish to keep full justification, you can use the following packages and 

options to turn off hyphenation: 

• \usepackage[none]{hyphenat}  

• \setlength{\emergencystretch}{3em}  

• \emergencystretch leads to a suboptimal layout, but ensures that no line sticks 

out too far to the right, which may otherwise happen if you turn off hyphenation.  
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4.8 ADAM/CMS: Styles  

Thanks to HTML, it is easy to make websites accessible. At the University of 

Basel, you will primarily deal with ADAM and university websites that are 

managed with the Typo3 and Magnolia content management systems. Design 

options are limited. 

Styles work in essentially the same way in ADAM and other CMS, so they are handled 

together here. 

Assigning Styles 

• Highlight the desired element  

• Under Paragraph format, select the desired format (typically paragraph for main 

body text, headings 1-x, bullet lists)  

Creating a new style 

It is not possible to create new styles in ADAM or in the university’s CMS. If you 

absolutely need a new style, contact your system administrator. 

4.9 ADAM/CMS: Font, paragraph, page 

On ADAM and in the Typo3 and Magnolia CMS, font types and sizes, line spacing, 

etc. are mostly preset in styles. It is generally not necessary to modify them, since 

readers can alter their browser settings to meet their needs.  

However, when working with ADAM, you should be aware of the following: 

• The ADAM editor’s preset line spacing is too small. The simplest way to fix this is 

by adding an empty paragraph after each line of text.  

• The pink color assigned to “accented” text does not provide enough contrast. 

Please avoid it.  
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Dark mode 

Students with migraines, cluster headache or other neurological conditions need to 

avoid glaring white backgrounds and prefer to work in dark mode. Most operating 

systems and browsers are able to display websites and software interfaces in dark 

mode: a dark background with a lighter font. On your own website, you can define the 

colour scheme for your dark mode in CSS: 

@media (prefers-color-scheme: dark) { } 

In ADAM and the University of Basel’s CMS, there is no dark-mode option at present; if 

you need a dark mode, please contact your systems administrator. 

4.10 PDF  

PDFs are practical, but they also pose significant accessibility challenges for 

blind and visually impaired individuals. Here we will show you how to make your 

PDFs more accessible. 

Making an existing PDF accessible 

Adobe Acrobat offers the best accessibility tools, for example for adding alternative text. 

However, the set-up differs greatly from one version of the program to the other. We 

therefore recommend that you identify your version and search for the appropriate 

instructions online. 

PDF from a scanned text 

Scanning text from a book or journal usually creates an image PDF. For a screen reader 

to be able to read the text, you should take the following steps. 

Use a professional book scanner (in the university library, for example) and select the 

following settings: 

• Scan format PDF (not image)  

• Page separation  

• Remove fingers  
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• Highest resolution possible  

• Grayscale  

This will produce an image PDF. This must now be converted into a text PDF using 

“Optical Character Recognition” (OCR). Different versions of Adobe Acrobat offer this 

function, for example:  

• Adobe Acrobat PRO 2017: Tools > Optimize Scanned PDF  

• Adobe Acrobat 9 Pro: Document > OCR Text Recognition  

OCR will convert the image PDF into an MS Word document. You can then follow the 

instructions in chapters 4 to 6 to make it accessible and save it again as a PDF. Besides 

Adobe Acrobat, there are other programs with good OCR functionality, such as ABBYY 

Fine Reader or Foxit. These are fee-based, but you can download a demo version and 

work with it for several days. 

A free alternative is the excellent open-source software “tesseract”. Unfortunately, it is 

difficult to use because it does not have a graphic interface, which means it has to be 

managed from the terminal. MacOS users can install the software with Homebrew or 

MacPorts, and tesseract is also available in most GNU/Linus distributions. 

More information is available at https://tesseract-ocr.github.io. 

 

  

  

https://tesseract-ocr.github.io/
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5 Details: Visual Elements 

5.1 MS Word: Tables and lists  

Tables pose significant challenges both for screen readers and for people who 

read with magnification. They must therefore either be formatted very carefully or 

converted into a list. MS Word offers a few options to help with this. 

Formatting tables for screen readers 

If a table is absolutely necessary to convey your content, please be aware of the 

following: 

• Create the table with Insert > Table. Never use tabs.  

• Once you have created the table, never change the number of columns or merge 

or split any cells.  

• Ensure that the first row contains meaningful column titles and that the first 

column (left) contains meaningful row titles. 

• Then mark the uppermost cell of the first column (furthest to the left) with the 

bookmark “Title”. This will allow the screen reader to identify your column and row 

titles as such. 

o Highlight the contents of the first cell.  

o In the “Insert” menu, under “Links”, click “Bookmark”.  

o Type a title into the “Bookmark name” field and click “Add”.  

Tables for reading with magnification 

Tabs (i. e. horizontal spaces within lines of text) can also be a major obstacle for people 

who read with screen magnifiers. Please avoid them and create tables instead. For 

optimal readability, the cells of your table should be divided with thick lines. 

• Click in the table.  

• In the menu that appears, click Table > Design > Set line weight.  
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Tables as lists 

Smaller tables ... 

Name Address Phone 

Clara Filler 1, University Street 061 123 45 67 

Peter Sample 4, Dean’s Square 078 123 45 67 

 

... can be formatted as a list (no bullet points or breaks): 

Name: Clara Filler 

Address: 1, University Street 

Phone: 061 123 34 56 

 

Name: Peter Sample 

Address: 4, Dean’s Square 

Phone: 073 123 45 67.  

Bullet lists 

You should use automatic list formatting to create longer and/or more complex lists. 

• First write the list as normal text (one paragraph per list element), then highlight 

the entire list.  

• Under “Start”, select your desired list format with bullets or numbering.  

• If your list contains sub-levels, you can format them with the “Multilevel list” button 

in the “Start” menu.  

5.2 MS Word: images and diagrams  

Obviously, images and diagrams present the biggest challenge for blind and 

visually impaired individuals. All information they contain must be verbalised and 
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presented in a way that can be understood by the screen reader. Also, the logical 

connections between the main text and image must be maintained. 

Alternative text 

Every image and diagram must be provided with an alternative text description. The 

screen reader reads this text aloud. Alternative texts should be as short as possible and 

as detailed as necessary. They should objectively describe what can be seen in the 

image. Avoid lead-in phrases such as “The image shows...” or “We see...”. When 

formulating alternative text, give particular thought to the teaching context: Why is the 

image important? What should students learn from it? 

How to insert alternative text: 

• Insert your image and highlight it.  

• Image tools Format > Alternative Text.  

• Enter the alternative text.  

Decorative elements 

Certain images have only a decorative or symbolic meaning, e. g. logos or a link symbol. 

If you mark these as “decorative”, the screen reader will ignore them. 

• Highlight the image.  

• Image tools Format > Alternative Text.  

• Instead of entering alternative text, check the “mark as decorative” box.  

Image caption or numbering 

To ensure that an image is properly connected to the text, you can number it and 

provide it with a legend. This also helps readers without disabilities to navigate the 

document. 

• Highlight the image.  

• References > Insert Caption.  

• Add the desired caption.  
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5.3 LaTeX: images and diagrams in LaTeX  

Images and diagrams present the biggest challenge for blind and visually 

impaired individuals. All information they contain must be verbalised and 

presented in a way that can be understood by the screen reader. Also, the logical 

connections between the main text and image must be maintained. 

Alternative text 

Use the command \Description[<short description>]{<long description>} within each 

figure, teaserfigure, marginfigure or table: 

• \begin{figure}  

• \centering  

• \includegraphics{Apple-trees}  

• \Description[A meadow with apple trees]{A meadow with eight tall apple trees at 

sunset. The apples have not yet been harvested.}  

• \caption{Apple trees before harvest}  

• \label{fig:Apple-trees}  

• \end{figure}  

Image caption or numbering 

• Use the \caption function (see also the above example under alternative text).  

The software automatically numbers the element. 

5.4 ADAM and CMS: images and diagrams  

Websites based on HTML offer excellent possibilities for making images and 

diagrams accessible. 

Alternative text on ADAM 

• Insert the image.  

• Click the image and select “Properties”.  
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• Under “Alternative text”, select the “Custom” option and enter the alternative text.  

Alternative text in the content management system 

Most CMS offer two ways of providing images with alternative text. Try these out to see 

what works: 

Variant 1 

• Insert your image in the text and highlight it.  

• Under Metadata, insert the alternative text.  

Variant 2 

• In your website’s back end, go to “File management” or “Media” or similar.  

• Highlight the desired image.  

• Enter the metadata, including the alternative text.  

Decorative elements 

Certain images have only a decorative or symbolic meaning, e. g. logos or a link symbol. 

For such images, you must leave the alternative text field empty. The screen reader will 

then ignore it. 

Image captions and numbering on ADAM 

• Insert the image.  

• Click the image.  

• Under “Image caption”, select the “Custom” option.  

• Enter the caption.  

Image captions and numbering in CMS 

In most CMS, image captions can be added in the same way as alternative text (there 

are two possible ways). Try these out to see what works: 

Variant 1 

• Insert your image in the text and highlight it.  
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• Under Metadata, insert the image caption.  

Variant 2 

• In your website’s back end, go to “File management” or “Media” or similar.  

• Highlight the desired image.  

• Enter the metadata, including the image caption.  

Reference to an image 

References to images within a page (“see figure 16”) work in the same way as other 

references within the same HTML page (see Chapter 7). Consult your system 

administrator as needed. 

5.5 Slide-based documents  

In order for the screen reader to be able to accurately read a slide, all the visual 

elements must be labeled with alternative text and placed in the right order. If you 

intend to provide the slides in PDF format, there are some additional factors you 

need to consider. 

Alternative text 

Follow the instructions for images and diagrams in the various programs in Chapter 5. 

Order of elements 

Unlike continuous text, on a presentation slide it is not always clear in which order the 

elements are meant to be read. Screen readers do not read the various elements from 

top to bottom or right to left, but rather in the order in which they were created.  

Here’s how to change the order in which your elements will be read in MS PowerPoint: 

• Start > Arrange.  

• Drag elements into the correct order (the screen reader will read the elements 

from bottom to top).  
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• Test the order by exporting the file to PDF and using the read-aloud function in 

Adobe Acrobat.  

You can also change the order of the elements directly in Adobe Acrobat, but the 

process varies depending on the version of the program. Here is the standard method: 

• Tools > Protection and standardise > accessibility; and then in the right column  

• reading order.  

Tips for presenting your slides in an accessible manner can be found in Chapter 8.2. 

Slides as PDF 

Perhaps you would like to provide your students with a PDF version of your slides. In 

this case, it is important to generate one page per slide. This allows your students who 

use keyboard commands to jump from slide to slide without having to scroll. The easiest 

way to do this is to simply save your slide presentation as a PDF without changing any 

settings. 
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6 Details: References, Language, Metadata 

6.1 MS Word: References  

MS Word offers numerous functions for structuring a document. Use them – they 

enable and facilitate navigation of documents not only for your blind or visually 

impaired students, but for everyone else too. 

Table of contents 

• Set your cursor on the position where you wish to insert your table of contents.  

• References > Table of Contents  

• Choose a layout.  

If you want to make changes to the text after creating a table of contents, you will have 

to update the table of contents. 

• Click in the table of contents.  

• Click above on “Update Table of Contents”.  

References, links, and footnotes 

The scroll function is useless for the blind, and people with motor disabilities may find 

scrolling difficult or impossible. For this reason, you should format any references in your 

text as hyperlinks. This applies to references to websites as well as document-internal 

references, including all references to a different location in the document (e. g. “see 

Chapter 2”), references to images or bibliographic references. 

How to create a document-internal reference: 

• Make sure that the target location is formatted correctly. (References can refer to 

headings, bookmarks, footnotes, endnotes, and images.)  

• Highlight the location where the reference should appear.  

• Click Insert > Cross-reference.  

• Select the target location and the type of reference.  
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How to create a reference to an internet destination (web link): 

• Place the cursor in the desired location or highlight the desired text element.  

• Insert > Link  

• Enter the destination URL.  

6.2 MS Word: languages  

Screen readers work with text-to-speech algorithms. In order to use the correct 

algorithm, the screen reader must receive a signal that tells it the language of a 

document or part of a document. 

Primary language 

The most important setting is a document’s primary language. Depending on the version 

of your program, the primary language may correspond to the spell-check language or 

you may be able to set it separately. Here’s how it works with the “spell-check” variant: 

• File > Options > Language  

• Under “Office Authoring and Editing Languages”, select the desired document 

language and set it as “default”.  

Section language 

MS Word also allows you to set the language for individual passages as needed.  

• Highlight the passage that differs from the primary language.  

• At the bottom of the program window, click on the language that is displayed (the 

document language).  

• In the window that appears, define the language for the highlighted passage.  

Foreign words 

Screen readers will usually mispronounce foreign words in a text. However, in a 

university context they are often unavoidable. You can assume that your blind students 

will generally be able to understand such terms. 
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6.3 MS Word: metadata  

Files not only have a file name, they may also be described by numerous 

metadata. These metadata can be read by screen readers and help your students 

to find/identify the file. 

Metadata 

Here’s how to enter metadata in MS Word: 

• File > Information > Properties  

• Specify the document name, tags and any comments.  

• Make sure that you are listed as the author. This is particularly important if you 

are not working on your own computer or are not logged in to your account.  

Please note that the document name that you set here will appear as the window or tab 

name for a PDF converted from the document. 

Watermarks 

Avoid using watermarks. These make the document difficult to read for people with 

visual impairments. 

6.4 LaTeX: references, languages and metadata  

In order to create references and define language in LaTeX, you first have to 

install the hyperref package. 

Table of contents 

LaTeX creates a table of contents with the command:  

• \tableofcontents.  

If the hyperref package is loaded, the command will automatically create the 

corresponding links. 
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Internal references 

Highlight the destination location with  

• \label{DESCRIPTION},  

and refer to it with  

• \ref{DESCRIPTION}.  

If the hyperref package is loaded, the two positions will be linked automatically. By 

default, LaTeX will use either the section or the figure number. To link to the page 

instead, use 

• \pagref{DESCRIPTION}  

External references 

Use the hyperref package. Here’s how to enter URLs: 

• \href{https://www.unibas.ch}{University of Basel}.  

Languages 

Use the hyperref package. Here’s how to set the language: 

• \usepackage[pdflang = {en}]{hyperref}.  

Metadata 

Specify the PDF metadata with the hyperref package: 

• \usepackage[pdfauthor = AUTHOR, pdftitle = TITLE]{hyperref}.  

6.5 ADAM and CMS: References  

Thanks to hyperlinks, websites based on HTML work very well for references. 

References to other pages 

References to other websites, to online PDFs and to other pages within the same URL 

can all be entered as a normal link. 
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• Place the cursor in the desired location or highlight the desired text element.  

• In the editor, click the link symbol.  

• Enter an external URL as the link destination or search the directory for an 

internal page.  

• Additionally, you should also enter a meaningful link title in the “Title” field, for 

example the name of the document you are linking. Without a link title, the screen 

reader will just read “link” without stating the link’s destination.  

• If you want to link to a download from your text – for example, to a PDF or audio 

file – you should specify the change of format: “Read this text as an article (PDF, 

4 MB)”  

Page-internal references 

CMS and Typo3 allow you to link internally to headings on the same page. 

• Make sure your link destination is formatted as a heading.  

• Highlight the location where the link should appear and click on the link symbol 

above.  

• In the window that opens, in the left column, select the page where the link 

destination is located (i. e. the page you are already on) and click the small black 

arrow.  

• Click the heading you wish to link to in the drop-down list. The link will be set.  

Languages 

Every website has a primary language, which can be set on the back end of the CMS. 

This primary language applies to the entire website (all pages under a domain) or, in the 

case of multilingual websites, to all pages in the selected language. In Typo3 and 

Magnolia you can use the integrated translation options: the system will then 

automatically set the HTML settings correctly. 

The lang attribute (<html lang="fr">) in the document header allows you to define a 

different language for individual pages. Consult your system administrator if you have 

questions about this function. Sections of pages in other languages must be specified in 
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the HTML code. However, on the University of Basel websites, manual code entry is 

disabled in Typo3 and Magnolia. On other websites, you can proceed as follows: 

• Click the HTML symbol <>. 

• Define the section language with this line of code: 

• <p>The primary text is in English, <span lang="fr">mais ce passage est en 

français</span>.</p>.  

Metadata 

When setting up a new page or website, make sure to define URLs that are meaningful 

and not too long. And don’t forget to define a page title – it appears in the browser tab 

and will be read aloud by the screen reader. 
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7 Details: Audio and Video 

7.1 Audio and video for hearing-impaired individuals  

Subtitles or transcripts are absolutely essential for hearing-impaired people to 

understand videos. They are also helpful for students without a disability; for 

example, if someone wants to watch a video without sound or doesn’t understand 

the language very well. 

“Closed” and “open” captions 

“Closed” means that the captions are saved in a separate file along with their time 

markers and the player plays them back parallel to the video. This means that the 

captions are easy to read even with compressed file formats and that they can be 

switched on and off as desired. “Open” captions, on the other hand, are part of the video 

and cannot be switched off. 

Captions vs. subtitles 

In English, we distinguish between “captions” and “subtitles”. Captions describe the 

entire soundtrack, including sounds and spoken language. Subtitles simply show the 

dialog, perhaps in a different language than the spoken language. All the common video 

processing programs offer the ability to manually insert subtitles and/or captions. Some 

are also able to produce captions automatically. Here, we will briefly describe how to 

add subtitles in Panopto. We recommend using the most common subtitle format, .srt. 

Adding subtitles with Panopto 

The University of Basel recommends Panopto software for working with videos and 

creating subtitles. 

• Import your video file to ADAM (in your workspace, “Add new object”) and then 

select “Panopto Video”.  

• Once the object is imported, click “Edit”. The Panopto web interface will open.  

• Select “Subtitles” in the Panopto interface.  
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• In the Language menu, set the subtitle language and type the text into the 

appropriate box. Hit the Enter key to save the subtitle.  

• Keep optimal contrast in mind: Click on the three dots on the bottom right to set 

font colour, size, position, and background.  

• When you have entered all the subtitles, you can adjust the times precisely by 

clicking on the three dots on the bottom right and selecting “Edit”.  

• Save the new video with subtitles with the “Apply” button. Alternately, you can 

write your subtitles in advance and then import them into Panopto.  

• To do this, write your subtitles in a text editor; for example, Notepad.  

• For each subtitle, use the following format: 

1. Identifier (must be a number)  

2. Time in the format HH:MM:SS, milliseconds optional  

3. Text of the subtitle  

4. Empty line as a divider before the next subtitle  

 

The first two subtitles for a typical lecture video will look something like this: 

1 

00:00:00 - -> 00:00:05 

Welcome to the lecture 

2 

00:00:05 - -> 00:00:22 

I hope this class will fulfil your expectations.  

• Don’t forget to transcribe any “meaningful” sounds.  

• Save the file with the extension .srt; for example, my-subtitles.srt. You must type 

the extension manually. The file type will remain “text file”.  

• In the Panopto web interface, in the “Subtitles” menu, select the “import subtitles” 

function.  
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Transcribing the audio track 

Subtitling – especially inserting the precise time markings – can be very time-consuming 

for a long video. Check whether you can convert the entire video into a text document 

with images, especially if a video mostly contains static images. Transcribing the audio 

track as text is much less work than subtitling. The transcription could also serve as the 

basis for a text document for visually impaired students. A good software program for 

transcription of audio files is VoiceDocs (https://voicedocs.com); it is however not free to 

use. 

Recording your own lecture 

For students with hearing impairments, it can be very helpful if you record your lectures. 

The students can listen to everything again at their own pace, replaying or slowing the 

recording as needed. Lectures presented online should ideally be pre-recorded (not 

presented live during a Zoom conference). This has the following advantages for 

hearing-impaired students: 

• Better sound quality  

• No acoustic disturbances  

• Subtitles can be created more easily.  

• The text and content are more linear, i.e. they contain fewer spontaneous 

tangents and reactions, which could make them difficult to follow.  

7.2 Video conferences for individuals with visual impairments  

People with visual impairments are able to participate in video conferences. 

However, be aware of the following with regard to presentations.  

Presentations 

When giving a slide presentation during a video conference or when sharing a screen, 

be sure to describe images and diagrams and read any text aloud. Although students 

with visual impairments can have the slides open on their own laptop, they can’t listen to 

both you and the screen reader at the same time. Additionally, the cursor is not visible to 

https://voicedocs.com/
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blind individuals and can be difficult to see for visually impaired individuals. Set your 

cursor to the largest symbol possible and always say out loud which element on a slide 

you are focusing on. You can change the cursor symbol on your laptop under the mouse 

or cursor settings. 

In conversation 

Blind and visually impaired individuals can hear everything that is said, but they cannot 

always tell who is speaking. For this reason, it is important to moderate carefully and 

always call on speakers by name. 

Chat 

Avoid parallel use of chat and spoken conversation whenever possible. If important 

content was shared in the chat, download the chat at the end of the video conference 

and send the file to your visually impaired students. 
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8 Definitions and legal framework 

8.1 Diversity and the right to inclusion  

Students with a disability or chronic illness have the right to full participation in 

their education – they have the right to inclusion. This is stipulated by national 

and international law. But what exactly do terms such as disability, inclusion and 

diversity mean? 

Diversity at the University of Basel 

In its Diversity Statement, the University of Basel expressed its firm commitment to the 

principles of diversity and inclusion: 

“As a place of work and education for around 19,000 people from over 100 countries, 

the University of Basel both relies on and is committed to diversity. The University of 

Basel values the varied experiences and perspectives of its employees and students 

and fosters the diverse potential of them regardless of age, religion, gender, gender 

identity, cultural background, language, social or professional status, lifestyle, political 

conviction, sexual orientation or disability.” 

Disability 

Today, disabilities are no longer understood as a unilateral deficit on the part of the 

affected person, but rather as the effect of an interplay between individual and societal 

factors. The UN Convention on the Rights of Persons with Disabilities defines disability 

as follows:  

“Persons with disabilities include those who have long-term physical, mental, intellectual 

or sensory impairments, which in interaction with various barriers may hinder their full 

and effective participation in society on an equal basis with others.” 

This definition of disability also appears on the website of Inclusion Handicap, the 

umbrella organisation of Swiss organisations of disabled persons. “Full and effective 

participation in society on an equal basis with others” is also known as inclusion. 

https://www.unibas.ch/en/University/Administration-Services/Vice-President-s-Office-for-People-and-Culture/Culture-Diversity-and-Leadership-Development/Diversity-and-Inclusion.html
https://www.fedlex.admin.ch/eli/cc/2003/667/en
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Chronic illness 

Chronic and mental illnesses can have a similarly disabling effect in daily life. In addition, 

they are often invisible. Students with chronic illnesses may therefore need the same 

support as students with mobility or sensory impairments. 

Inclusion 

Inclusion means that all people can participate in society with equal self-determination 

and with the full range of choices. It also means that aids and compensations for 

disadvantage are provided as a matter of course and do not have to be fought for 

individually in each case. In order to guarantee inclusion, institutions such as the 

university must remove any obstacles proactively. 

Accessibility 

Accessibility means that the obstacles for people with disabilities or chronic illnesses are 

removed or compensated for. In the context of university studies, this means that: 

• Buildings, rooms and teaching and learning spaces are accessible 

• Communication is adapted to students’ needs 

• Teaching methods and teaching/study materials are adapted to students’ needs 

• Schedules are adapted where necessary 

• Examinations and other proofs of performance can be individualised to meet 

students’ needs 

• Flexible handling of new challenges at every level. 

8.2 Legal framework  

The right to education for people with disabilities and the resulting 

responsibilities for educational institutions are set forth in various international 

treaties and in the Swiss constitution and national laws. 
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Constitutional ban on discrimination 

In agreement with various international human rights treaties, the Swiss Federal 

Constitution bans every kind of discrimination in Art. 8., para. 2:  

“No person may be discriminated against, in particular on grounds of origin, race, 

gender, age, language, social position, way of life, religious, ideological, or political 

convictions, or because of a physical, mental or psychological disability.” 

The UN Convention on the Rights of Persons with Disabilities 

The UN Convention on the Rights of Persons with Disabilities (CRPD) has been in place 

in Switzerland since 2014. It obliges the member states to wide-ranging measures to 

promote the participation of persons with disabilities in the life of society. In Article 24, it 

describes the right of people with disabilities to develop “their personality, talents and 

creativity, as well as their mental and physical abilities, to their fullest potential”. 

Federal Act on the Elimination of Discrimination against People with Disabilities (DDA) 

The Federal Act on the Elimination of Discrimination against People with Disabilities 

(DDA) enables the Swiss authorities at federal level to combat discrimination against 

people with disabilities. For the education sector, in Art. 2 para. 5a, it names the 

following forms of discrimination, which it is empowered to eliminate: 

“Discrimination in access to general and advanced education and training occurs in 

particular when: 

a) it is difficult for persons with disabilities to use aids or obtain the necessary assistance 

from other persons; 

b) the duration and organisation of the course and examinations are not adapted to the 

specific needs of persons with disabilities.” 

Law on the rights of people with disabilities, Canton of Basel-Stadt 

The Canton of Basel-Stadt is also committed to accessibility and wants to play a 

pioneering role in this area. The canton firmly holds that: 

https://www.fedlex.admin.ch/eli/cc/1999/404/en
https://www.fedlex.admin.ch/eli/cc/1999/404/en
https://www.ohchr.org/en/instruments-mechanisms/instruments/convention-rights-persons-disabilities
https://www.fedlex.admin.ch/eli/cc/2003/667/en
https://www.fedlex.admin.ch/eli/cc/2003/667/en
https://www.entwicklung.bs.ch/behindertenrechte.html
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“Persons with disabilities [...] [should] be able to realize their rights in all areas of life. 

The goal is a self-determined and independent life.”  

The legal basis is the Law on the rights of people with disabilities 

(Behindertenrechtegesetz, BRG), which went into effect on 01.01.2021 and which also 

applies to the University of Basel. 

University of Basel 

The University of Basel already committed to advancing the needs of students with 

disabilities in 2011, in its Disability Statement:  

“[The university] provides specific services to facilitate accessible studies for students 

with handicaps and to guarantee the legal right to equal participation in educational 

programs.” 

In 2020, the university released its Code of Conduct, and it speaks out here against 

every form of discrimination:  

“We do not tolerate discrimination on the grounds of age, gender, gender identity, 

background, language, sexual orientation, religion, political opinion, mental or physical 

disability or personal lifestyle and circumstances.” 

The 2012 University Statute also states in § 6 that the university facilitates studies for 

students with disabilities. Various study regulations contain guidelines for Various study 

regulations contain guidelines for accommodations and compensations. The Teaching 

Committee approved the Process for Compensating for Disadvantages in 2015. 

 

  

  

https://www.gesetzessammlung.bs.ch/app/de/texts_of_law/140.500
https://www.gesetzessammlung.bs.ch/app/de/texts_of_law/140.500
https://www.unibas.ch/dam/jcr:49a6d270-912d-4e1f-a3b0-4785e36c450a/25_10_2011%20Disability%20Statement%20final_barrierefrei.pdf
https://www.unibas.ch/dam/jcr:fda7a469-0079-40aa-9f01-9faa9d255872/Code%20of%20Conduct_University%20of%20Basel_2020_EN.pdf
https://www.unibas.ch/dam/jcr:32a514d4-9b88-4fbe-adc2-71bf8b77c784/FRM_gh_Musterantrag-Nachteilsausgleich-verabschiedetKL_20151202.docx
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9 Further information 

9.1 Resources from other organisations  

Here are some links for further information and instructions on accessibility in digital 

instruction (mostly in German).  

Accessible layout 

• The University of Cologne has further instructions in PDF format: 

https://portal.uni-

koeln.de/sites/uni/PDF/Erstellung_barrierefreier_Dokumente_Leitfaden_UK.pdf  

• Video tutorials on creating accessible content: 

https://www.youtube.com/playlist?list=PLI5fPE8N5j5zklmm1XYNF-cNzIdhySmm1  

• Further information on accessible publication of text:  

https://www.netz-barrierefrei.de/wordpress/barrierefreies-publizieren/  

Accessible website design 

• https://www.unibas.ch/de/Universitaet/Administration-Services/Bereich-

Rektorin/Kommunikation-Marketing/Web-Services/Web-Desk/Barrierefreiheit.html  

Creation of accessible PDFs 

• https://helpx.adobe.com/ch_de/acrobat/using/creating-accessible-pdfs.html  

• https://www.access-for-all.ch/ch/pdf-werkstatt.html  

Alternative text 

• The best tips for writing alternative text can be found in instructions for writing 

image captions:  

https://www.wikihow.com/Write-Good-Captions-in-Photojournalism  

• https://www.wikihow.com/Write-a-Caption  

https://portal.uni-koeln.de/sites/uni/PDF/Erstellung_barrierefreier_Dokumente_Leitfaden_UK.pdf
https://portal.uni-koeln.de/sites/uni/PDF/Erstellung_barrierefreier_Dokumente_Leitfaden_UK.pdf
https://www.youtube.com/playlist?list=PLI5fPE8N5j5zklmm1XYNF-cNzIdhySmm1
https://www.netz-barrierefrei.de/wordpress/barrierefreies-publizieren/
https://www.unibas.ch/de/Universitaet/Administration-Services/Bereich-Rektorin/Kommunikation-Marketing/Web-Services/Web-Desk/Barrierefreiheit.html
https://www.unibas.ch/de/Universitaet/Administration-Services/Bereich-Rektorin/Kommunikation-Marketing/Web-Services/Web-Desk/Barrierefreiheit.html
https://helpx.adobe.com/ch_de/acrobat/using/creating-accessible-pdfs.html
https://www.access-for-all.ch/ch/pdf-werkstatt.html
https://www.wikihow.com/Write-Good-Captions-in-Photojournalism
https://www.wikihow.com/Write-a-Caption
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MS Word 

• Microsoft’s support pages offer detailed instructions for all functions of MS Word: 

https://support.microsoft.com/en-us/office/customize-or-create-new-styles-

d38d6e47-f6fc-48eb-a607-1eb120dec563  

The WCAG standard 

The WCAG standard (Web Content Accessibility Guidelines) has been developed for 

websites and all web content. Here is a description of the standards:  

https://www.w3.org/WAI/WCAG21/Understanding/  

The University of Basel website meets all the WCAG standards, so you can share 

information on these pages without any additional measures as long as you observe the 

general guidelines for text and images.  

General 

General information on accessibility in digital spaces can be found at the Access for All 

Foundation:  

https://www.access-for-all.ch/ch/  

https://support.microsoft.com/en-us/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563
https://support.microsoft.com/en-us/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563
https://www.w3.org/WAI/WCAG21/Understanding/
https://www.access-for-all.ch/ch/

